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THE
U.S.S.BLACKHAWK

TECHNICAL MANUAL
INTRODUCTION

TO ALL NAVY PERSONNEL

TO ALL NAVY PERSONNEL- You are a part of the
largest and strongest seagoing force in the world.
When you were sworn in and put on your uniform

for the first time, you became part of a great
tradition. All the brave men and women who have
gone before you, and those who will follow you,

make up an unbroken chain of courage and
devotion to duty that should make you proud to

wear your uniform.

Service in the Navy can be whatever you make it. It
takes some time to understand and become

adapted to the ways of the Navy, for going to sea
in ships is a tough, serious business, particularly
in troubled times. If you must work hard at times,

miss a leave period or a few liberties in your home
port, remember that you chose a demanding job

when you joined the Navy.

BOARDING PROTOCOL
-

Salute Flag - When standing on the gangway, prior to stepping aboard, face aft and
'salute the flag'.

Salute Officer of the Deck - After the above, turn and face the Officer of the Deck,
salute and 'request permission to come aboard.'

Presenting orders - After requesting 'permission to come aboard,' the Officer of
the Deck will inspect your orders and grant you permission to board.

THE EXECUTIVE OFFICER

Duties and responsibilities -
The Executive Officer is the number two man under the Captain. His responsibilities
are to provide leadership to all men under him while maintaining a feeling of good
spirit. The Executive Officer will take command of the ship during any absence of .
the Captain. It shall be the responsibility of the Executive Officer to insure the opera-
tional status of his vessel by inspecting and cycling equipment in the following areas:

1) Control room
2) Machinery compartment
3) Torpedo room
4) Engine room



CONTROL ROOM

PERISCOPES
(Attack & Observation)
Use your periscopes to determine the exact location of an object on the surface. The
left and right [Arrow] keys will adjust the heading of the scope. When you have lo-
cated an object, take note as to its location.

Scopes should only be used at periscope depth (approx. 70'). Severe damage may
occur if the 'attack scope' is used at speeds in excess of 5 knots. Severe damage may
also occur if the 'observation scope' is used at speeds in exces of 12 knots.

SONARMAN
The sonarman is situated in the control room next to the radioman and to the left of
the control panel. Contact with the sonarman and radioman can be made by walking
over to them and talking to them.

COMMUNICATIONS
Coded messages
All messages received aboard the U.S.S. Blackhawk will be in coded format and
shall be received through the radioman.

Decoding messages
Aboard the U.S.S. Blackhawk can be found a book entitled US Naval Intelligence
Decoding. This book must be used in conjunction with your technical manual. The
word keys used for decoding can be found within the 'boxed shaded' areas. The
coded numbers represent page, line and word. All coded numbers are in the range 0-
9.

CHARTS
(Located in control room)
Course plotting
Enclosed within the packaging of this game is a foldout map. Use this map for deter-
mining and plotting your course heading.

Coordinates
Using a straight edge, plot your course on the foldout map. When it is necessary for
the submarine to change from a direct course, make note of the longitude and
latitude of the 'waypoint' (the point at which you'll change direction). These are
your coordinates.

The initial overall course to be followed will be given to you using landmarks. Using
the foldout map and the landmarks as a guide, chart your 'way points' on the map

and then enter them into the computerized charts table located in the control room.
You may also receive information via radio, of other specific way points for rendez-
vous purposes. Type: look map to get a close-up view. The flashing point on the
map represents your vessel at its current location.

To begin entering way points Type: plot course.

When entering the way points, use the directional keys until the longitude and
latitude that you have calculated on the foldout map are displayed. Depress the
[ENTER] key on your keyboard to enter the way point. To change a way point al-
ready entered Type: change point. Repeat the above sequence until you have
entered all your way points. When entering the last way point, depress the [ENTER]
key twice.



CONTROL PANEL

1. MAP

2. FIRE CONTROL PANEL
3. VERTICAL SONAR
4. RANGING SONAR
5. DEPTH GAUGE
6. WATER TEMPERATURE

7. TIME CLOCK
8. SPEED (IN KNOTS)

9. RPM INDICATOR
10. STERN PLANE INDICATOR
11. LONGITUDE INDICATOR
12. DIVE LEVER
13. ENGINE LEVER
14. BALLAST INDICATOR
15. SILENT RUN ON/OFF
16. SILENT RUN INDICATOR
17. SONAR ON/OFF

18. ATTITUDE INDICATOR
19.WHEEL
20. CLOSED CIRCUIT TV ON/OFF

21. TORPEDO TUBE INDICATOR ON/OFF
22. TORPEDO TUBE FLOOD ON/OFF
23. FIRE CONTROL PANEL ACTIVATE
24. RUDDER INDICATOR
25. EMERGENCY BALLAST CONTROL
26. HATCH INDICATOR

27. COMPASS
28. LATITUDE INDICATOR
29. BOW PLANE INDICATOR

30. HEADING INDICATOR
31. MULTIPURPOSE VIEW SCREEN
32. THROTTLE SPEED INDICATOR
33. DIVE PLANE INDICATORS

1. Map Display:
Use to determine present location at all times.

2. Fire Control Panel:
The Fire Control Panel consists of four controls. From left to right their functions
are as follows:
A. Select weapon (Use the Shift F5 key, or click on with mouse).

Target selection is fully automatic.
B. Lock on target (Use the Shift F6 key, or click on with mouse).
C. 3-D Imaging Display (Use the Shift F7 key, or click on with mouse).
D. FIRE (Use the Shift F8 key, or click on with mouse).

SONAR:
There are two types of sonar used in the U.S.S. Blackhawk:
Passive sonar - Listening for sound produced by other vessels, responsibility of
sonarman.
Active sonar - Sending out sound waves to detect underwater objects. Size and
distance can be measured when an object has been detected. Active sonar consists
of Vertical and Ranging Sonar, explained below.

3. Vertical Sonar:
Vertical sonar determines the distance above and below your submarine to a solid
object such as an iceberg or the ocean floor. The center point on the screen repre-
sents your vessel. Each line on the screen represents 10 ft above or below your
vessel. When an object is present within 100 ft above or below the sub, the lines
on your screen become highlighted to indicate the distance of the object from
your location.

4. Ranging Sonar:
Ranging Sonar indicates obstacles within a 1000 yd. radius around the submarine.

5. Depth Gauge:
Displays current depth.

6. Water Temperature Gauge:
Displays current water temperature in degrees
Celsius.

7. Time Clock:
Displays current
time of day.

8. Speed Indicator:
Displays speed in
knots.

9. RPM Indicator:
Displays engine
Revolutions Per
Minute.



10. Stern Plane Indicator:
Indicates the angle of inclination of the Stern Plane.

11. Coordinate Display Screen (Position Indicator):
This screen shows you the course cooridnates of your last way point.

12. Dive Lever:
Use this lever to increase or decrease ballast, which will allow you to set the bow
and stern planes so that your sub may surface or dive. Using the up and down
[Arrow] keys, move the lever up and down. Using the mouse, place the mouse
cursor on the lever and hold down the left mouse button. Now move the cursor in
the direction you wish to adjust the lever.

13. Engine Lever:
Use this lever to adjust the running speed of the submarine. Use the [+] key to ac-

celerate, the [-] to decelerate. Using the mouse, place the mouse cursor on the
lever and hold down the left mouse button. Now move the cursor in the direction
you wish to adjust the lever.

14. Ballast Indicator:
Indicates ballast level in four separate tanks aboard the submarine.

15. Silent Running On/Off:
Activates or deactivates Silent Run. When Silent Running is active, noise
eliminating transducers mask noise produced by the submarine, reducing the
likelihood of discovery by a hostile force. (Use the Shift F4 key, or click on with
mouse)

16. Silent Run Indicator:
Indicates whether Silent Running is active.

17. Sonar On/Off:
Activates or deactivates the active sonar. •
( Use the Shift F3 key, or click on with mouse).

18. Attitude Indicator:
Gauges the vertical angle of the'submarine.

19. Wheel:
You can change direction using the left and right [Arrow] keys to turn the wheel.
If you're using a mouse, place the mouse cursor on the wheel and hold down the
left mouse button. Continue holding the left button as you move the cursor to the
left or right.

20. Closed Circuit Monitor On/Off:
This monitor enables the navigator to see any obstacles in the path of the sub. The
closed circuit system is vital to successful navigation.
(Use the Shift Fl key, or with click on mouse).

21. Torpedo Tube Flood Control Indicator:
Indicates whether Torpedo tubes have been flooded.

22. Torpedo Tube Flood On/Off:
Floods torpedo tubes. Switches automatically when weapon locks on.

23. Fire Control Panel Activate Button:
Lowers Fire Control Panel from ceiling for easy access.,
(Use the Shift F2 key, or click on with mousej.

24. Rudder Indicator:
Indicates the current position of the Rudder.

25. Emergency Ballast Control:
In the event of an emergency, it may be necessary for the Blackhawk to surface
quickly. The emergency ballast allows the sub to surface automatically under
most conditions.

26. Hatch Indicators:
There are 3 exterior hatches aboard the U.S.S. Blackhawk. The purpose of the
hatch indicators is to keep you informed as to whether the exterior hatches are
open or closed. If an indicator is lighted, a hatch is open.

27. Analog Compass
Shows compass heading by the position of a needle in relation to a compass point
indicating true North.

28. Coordinate Display Screen (Latitude Indicator):
This screen presents you with your current latitude coordinates at all times.

29. Bow Plane Indicator
Indicates the angle of inclination of the Bow Plane.

30. Heading Indicator
Displays compass heading in numbers.

31. Multipurpose View Screen
Use to view weapons selection when using Fire Control Panel, also serves as
monitor for Closed Circuit Television.

32. Throttle Speed Indicator
'A.-Lights out- Throttle Stopped.
B. 1 light- Throttle slow
C. 2 lights- Throttle 1/3
D. 3 lights- Throttle 2/3
E. 4 lights- Throttle full
F. All lights red- Throttle reverse

33. Dive Plane
Indicators
Indicates dive
plane position
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TORPEDO ROOM MISSILES EQUIPMENT & SYSTEMS

HARPOON
The 'Harpoon' missile is an active radar homing weapon. It delivers a 1000 Ib.
penetration/blast warhead over ranges of up to 150 nautical miles against surface ship
targets. It is propelled by a solid rocket booster and turbojet sustainer, and after reach-
ing a maximum altitude of 5,000 ft. it cruises at high subsonic speed.

TORPEDOES
STING RAY
The 'Sting Ray' is active/passive homing to 35 nautical miles at 90 knots. It delivers a
1000 Ib. warhead taa depth of 5,000 ft.

EMERSON ELECTRIC MK 2 TORPEDO DECOY
The decoy torpedo is used as a counter measure against attack. The decoy emits a
sound signature identical to the mother ship from which it is launched. Decoys need
not be targeted.

EXPLOSIVES
Plastic explosives for underwater demolition can be found aboard the U.S.S. Black-
hawk.

TUBES
The U.S.S. Blackhawk has four forward torpedo tubes which may be used to launch
all weapons.

MACHINERY COMPARTMENT
The machinery compartment consists of tools used to reproduce parts in the event of a
breakdown. Other life support systems can also be found, such as fresh water, oxygen
and scrubber systems.

FRESH WATER SYSTEM
Sea water is desalinated and then distilled to remove minerals. Fresh water is stored
for crew use and to generate oxygen.

OXYGEN
Fresh water is pumped into oxygen generator, high amperage (1,050 amps) electricity
separates the hydrogen from the oxygen. Hydrogen is pumped overboard and oxygen
is stored in a bankpf high pressure oxygen bottles. Oxygen is bled into atmosphere as
required.

SCRUBBERS
Various" gasses in the atmosphere are maintained at acceptable levels by filtering out
excess.

NUCLEAR COMPARTMENT
General Electric pressurized water cooled S6G reactor. Two geared turbines, one
shaft. Due to the extreme hazard of radiation exposure in the nuclear reactor compart-
ment, admittance is not allowed.
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DEFENSIVE STRATEGY (WHEN ATTACK IS IMMINENT) US NAVY TERMINOLOGY

PREPARING FOR ATTACK
If you believe attack is imminent, it's very important to react quickly! The following
suggestions will aid you in the survival of your submarine and crew.

RUN SILENT
The key to submarine survival is evasion through 'stealth' or silent running. The
U.S.S. Blackhawk is equipped with the latest in electronic noise eliminating
transducers which are located at various points along the propeller shaft. The
transducers are attached to the steel casing surrounding the shaft. They pick up
generated sound waves which are fed into a computer. The computer creates the
exact opposite phase sound wave which cancels out the noise. This makes for much
improved silent running; however, the transducer is only effective if the submarine is
operated at speeds of 5 knots or less.

SONAR
Passive sonar is a must, because active sonar will give away your position. As soon
as possible, confirm a fix on enemy target.

WEAPONS
You must first select, a weapon. When using harpoon missies and Sting Ray Tor-
pedoes you MUST first lock on to your target. Remember that a weapon launch may
temporarily give away your position during silent running.
Decoy torpedo may be used to draw enemy fire if under attack.

DIVE DEEP , '
Diving deep and changing course will aid your evasion tactics. In some instances the
bottom terrain will help hide your position.

INVERSION LAYERS
A layer of water that is warmer than the surrounding water is called an inversion
layer.
An inversion layer
will deflect sonar
signals from above.

Aye aye
Fish
Stern
Aft
Bow
Port
Starboard
Stern Planes
Bow Planes
Rudder
Ballast Tanks
Flooding tubes
Green board
Hatch
Screws
Signature
Active Sonar
Passive Sonar
Ping

Yes Sir
Torpedo
Rear of ship
Near, toward or in the stern of a ship
Front of ship
Left side of ship
Right side of ship
Submarines rear navigational diving planes
Submarines front navigational diving planes
Submarines left/right navigational control
Diving and surfacing controls
Flooding torpedo tubes in preparation for launch
All control room systems ready for diving
Passage way in, out, or through submarine
Ships propellers
Identifying ships through their unique sound
Sending active sound waves
Listening for sound created by other ships
Active sonar sound
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FIRST AID PROCEDURES

CARDIOPULMONARY RESUSCITATION (CPR)
CPR is an emergency life saving technique. To understand how CPR can sustain life,
consider these two definitions of death:

A. CLINICAL DEATH - The heartbeat and breathing have stopped. This is also
known as near or apparent death, and it may be averted, or reversed. 'Sudden Death'
is sudden, unexpected clinical death. Some common causes of sudden death are:
Cardiac arrest *.
Electric shock
Drowning
Drug overdose
Suffocation
Severe allergic reactions

B. BIOLOGICAL DEATH - Permanent brain death due to lack of oxygen.

During the first few minutes of clinical death, promptly initiated CPR may turn the
victim back to productive life. Without CPR, biological death will occur. Speed in
starting CPR and in getting specialized medical care for the victim are the keys to
saving lives.
When CPR is started within 4 minutes, the victim's chances of leaving the hospital
alive are four times greater than those of a victim who does not receive CPR "until
after 4 minutes.
As a rescuer acting in good faith, you should remember that once CPR has begun,
you may stop only when:
1. The victim recovers
2. Another trained individual takes over.
S.You are too exhausted to continue.

Cardiopulmonary resuscitation includes three basic rescue skills, the ABC'S of CPR:
Airway, Breathing, and Circulation.

AIRWAY - The first action for successful resuscitation is immediate opening of the
airway. It is' important to remember that the back of the tongue and the epiglottis are
the most common cause of airway obstruction in the unconscious victim. Since the
tongue directly, and the epiglottis, indirectly, are attached to the lower jaw, tilting the
head back and moving the lower jaw (chin) forward lifts the tongue and the epiglot-
tis from the back of the throat and usually opens the airway.
BREATHING - When breathing stops, the body has only the oxygen remaining in
the lungs and bloodstream. It has no other oxygen reserve. Therefore, when breath-
ing stops, cardiac arrest and death quickly follow. Mouth-to-mouth rescue breathing

is the quickest way to get oxygen into the victim's lungs. There is more than enough
oxygen in the air you breath into the victim to at least partly supply his or her needs.
Rescue breathing must be performed until the victim can breath on his or her own or
until trained professionals take over.

Remember: If the victim's heart is beating, you must (1) maintain an open airway
and (2) breath ( for the adult victim) once every 5 seconds (12 times per minute). If
the victim's heart is not beating, you will have to perform mouth-to-mouth rescue
breathing plus chest compressions.

CIRCULATION - The third skill of CPR is chest compressions, which replace the
heartbeats of the victim. They maintain some blood flow to the lungs, brain,
coronary arteries, and other major organs. Any time chest compressions are per-
formed, mouth-to-mouth rescue breathing must also be performed.

NOTE: THE FOLLOWING (ONE MAN) CPR PERFORMANCE GUIDELINE
WAS TAKEN FROM THE 1987 'HEARTSAVER MANUAL' BY THE
AMERICAN HEART ASSOCIATION.
1. Lay Victim On Back (Head Must Not Be Above Level Of Heart)
2. Shake And Shout To Establish Responsiveness
3. Call For Help
4. Establish The Airway ( Open The Mouth And Sweep With Fingers)
5. Look, Listen, And Feel (Look For Chest Rising, Listen For Breath, Feel For
Breath With Cheek.)
6. Give 2 Good Breaths (After Tilting Head Back And Opening Mouth)
7. Repeat Step #5.
8. Check Pulse For 5-10 Seconds.
9. After The Above Steps And Still No Vital Signs, Begin Compressions. Position Heel
Of Hands Approx. 3 " Above The End Of The Sternum. Compress The Chest 11/2-2'
At A Rate Of 100 Times Per Minute. The Ratio Of Compressions To Breaths (for 1 Per-
son) Are, 15 Compressions To 2 Breaths. Check For Pulse Every Minute. Continue
Step #8 Until Breathing And Pulse Are Established Or, Until Competent Help Has Ar-
rived To Relieve You.
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HOW TO READ THIS MANUAL

Throughout this manual we will use the following ways of representing information:
MENU COMMANDS will be CAPITALIZED.
Example: SAVE, RESTORE, QUIT, PAUSE GAME
Typed commands will appear as bold type.
Example: 'type: [example game command]'
'type: cd \sierra'
Portions of the command line not meant to be typed will not appear in bold type. For
example, in the line 'type: cd \sierra', 'type:' should not be typed.
[EXAMPLE TEXT] and [Keystrokes] will appear in brackets setting them off from the
surrounding text.

• Example: [NAME OF GAME] [NAME OF DIRECTORY] [Spacebar], [Tab], [Page-
Up]
The brackets are not keystrokes and should not be typed.
Two or more keys that should be pressed at the same time will be separated by a hyphen
(-). This hyphen is not a keystroke, and should not be typed.
Example: 'Press [Ctrl-I] to view your inventory.'
If a space appears between parts of a command, it is meant to be typed.
Example: 'type cd \sierra' (the space between cd and \sierra should be typed as part
of the command)
The term 'diskette' is used to refer to either 3.5" or 5.25" data-Storage disks.

ALL SYSTEMS
PLEASE NOTE: If there is a README file on your game diskette. It may contain
important information and instructions that were not available at the time the
documentation and other materials for this game were printed. Failure to review the
README file before installing the program may cause unexpected results during
installation, loading or playing the game.

MS-DOS README INSTRUCTIONS
From DOS, type readme to see the README file onscreen. Use [PageUp]/[PageDown]
keys to scroll through the file.

ATARI ST README INSTRUCTIONS
To view the README file from the desktop, double-click on the README.DOC icon.
You will see a message box with choices for SHOW, PRINT, and CANCEL. Choose
SHOW to view the file onscreen one page at a time. Press [ENTER] to see the next
screen. Choose PRINT to print the file. Choose CANCEL to escape the message box.

AMIGA README INSTRUCTIONS
Insert Workbench disk into drive DFO: and turn on your system. Double click on the CLI
icon.
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Users with one drive: Copy the TYPE command into your RAM disk. See your
Amiga owner's manual for instructions. Insert Disk 1. Type: type readme.
Users with more than one drive: Insert Workbench in drive DFO:. Insert Disk 1 in
drive DF1:. Type cd df 1:. Type: type readme.

GETTING STARTED: DISKETTE DRIVES
It is always advisable to make back-up copies of your master program diskettes to
increase the life of the masters and guard against accidents. Follow your computer's
instructions to make copies of all game diskettes.
Even if you will be playing from a hard disk, you may want to format a blank diskette
for saving games. In fact, saving games to diskettes is a good idea, even if you are playing
the game from your hard disk. Follow your computer's instructions to format a blank
diskette and keep it handy for saving your game as you play. For some helpful tips on
saving games, see the 'Saving Your Game' (Page 24) section of this manual.
When installing your program, you may be prompted to insert a 'Drivers' disk. If you
receive this prompt, please examine your disks and insert the disk marked 'Drivers' and
press [ENTER], so that the appropriate drivers will be loaded. Some games do not include
a separate 'Drivers' disk.

MS-DOS
INSTALL THE GAME
Place the back-up copy you have made of Disk 1 into your diskette drive. Type the letter
of the disk drive you have placed the disk into followed by a colon (for example: a:),
and press [ENTER]. Type: install and press [ENTER].
Answer the onscreen questions using the up and down [Arrow] keys to highlight your
selections, then press [ENTER] to select. You will be aske.d if you wish to install the
game on your hard disk. If you do not wish the game to be installed on your hard disk,
press [ESC] to skip this step. If you want to install the game on your hard disk, enter the
letter designation of your hard disk (usually C) and follow the prompts.
PLEASE NOTE: Even if you install to a hard disk, the install procedure will write a
file namedRESOURCE.CFG to Disk I. For the installation to be completed correctly,
DISK 1 MUST NOT BE WRITE PROTECTED. No other files on Disk 1 are written
or changed by the install command.

LOADING INSTRUCTIONS
After completing the INSTALL procedure:
From diskettes:
1. Place Disk 1 into the A: drive.
2. Type: a: and press [ENTER].
3. Type: sierra and press [ENTER].
From hard disk:
1. From your root directory, type cd \sierra and press [ENTER].
2. Type [SPECIFIC COMMAND] and press [ENTER].
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SAVING GAMES TO DISKETTES
PLEASE NOTE: If you 're playing from diskettes, you must have a separate formatted
diskette ready before you can save a game. We also recommend that you create several
directories on your save game disk in order to assure adequate space for save game
storage.
Choose SAVE GAME from the File menu or press the [F5] key. The Save Game menu
will appear.
Use your [Tab] key to choose CHANGE DIRECTORY. Backspace or press [Ctrl-C] to
clear the command line.
Type the letter of the drive you are using for saved games, followed by a colon (Example:
a:) and press [ENTER].
Type the name of your saved game and press [ENTER] to complete the SAVE GAME
procedure. If your disk for saving games is full, you may reformat it (this will erase the
saved games on the disk) and use it over, or use another formatted blank disk.

SAVING GAMES TO HARD DISK
If you choose to save games to the hard disk, the program will automatically try to save
to the game's own directory. If you run out of space for saving games, try one of the
following alternatives:
Save additional games to a diskette.
Save games to a different directory by choosing CHANGE DIRECTORY from the
SAVE GAME menu (inside the game).
Create a new hard disk directory from DOS, using DOS instructions.Delete all saved
games and the saved game directory from your hard disk by following DOS instruc-
tions (outside the game). The program will create a new index file within the game
directory.

ATARI ST
LOADING INSTRUCTIONS
Note: If you are using an Atari 520 ST without memory expansion, turn off all desk
accessories (rename .ACC extension .ACX) before running your Sierra game.
1. If you are playing the game from diskettes: Place Disk 1 in drive A, and open the
disk by double-clicking on its icon. Start the game by double clicking on SIER-
RA.PRG.
2. If you are playing the game from a hard disk: Open the disk by double-clicking on
its icon, then open the game folder by double-clicking on the game folder icon. Start
the game by double-clicking on SIERRA.PRG

HARD DISK INSTALLATION
Please note: -More than 512K of memory is needed in order to run Sierra games on you
ST If you have a hard disk.
1. Open the hard disk by double-clicking on its icon.
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2. Create a game folder by choosing NEW FOLDER...from the File menu. Open the
new folder by double-clicking on its icon.
3. Place Disk 1 in drive A.
4. Copy the game disk into the new game folder by dragging the drive A icon into the
window you opened in Step 3.
5. Repeat steps 3 and 4 for each of the other game disks.
6. Put the master disks away in a safe place.

CHOOSE A MUSIC DEVICE (Optional)
Your Sierra game is initially set up to play music and sounds through the Atari ST's
internal speaker. If you have one of the supported MIDI synthesizers, you may run the
MUSIC program to have the game play music through the synthesizer.
1. Open the game disk/folder by double-clicking on its icon.
2. Run the MUSIC program by double-clicking on the MUSIC.PRG icon.
3. Select MUSIC DEVICE from the Options menu.
4. Select your synthesizer (or 'Atari ST Internal Sound') by clicking on the ap-
propriate button. Then click on OK.
5. Select INSTALL GAME from the File menu. This will replace the
RESOURCE.CFG file on your disk.
Please note: It is important to turn your synthesizer on before starting the game.

AMIGA
INSTALLING THE GAME
NOTE: RENAME your copies of all game disks to remove the words 'COPY OF' from
the disk name. If the words 'COPY OF' are not removed from the disk names of ALL
the copies, the system will continue to ask for the original disk, and will not run the
game.
1. Boot your system with Workbench, and insert Disk 1 of your Sierra game.
2. Double-click on the disk icon, then double-click on the INSTALL icon.
3. Follow the onscreen prompts, choosing your selection with the mouse by clicking
once on the item.
4. You will be asked if you wish to install the game on your hard disk. If you do not
wish the game to be installed on your hard disk, select NO. If you want to install the
game on your hard disk, select YES.
5. Using your mouse, select the drive on which you wish to install the game.
6. Follow the onscreen prompts to complete the installation.

LOADING INSTRUCTIONS
From Diskettes:
1. If you have less than 1 megabyte of memory for your Amiga, turn your system off
and disconnect any external drives.
2. Insert Disk 1 into drive DFO:.
3. Turn on your system.
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From Hard Disk:
1. Load Workbench and double-click on your hard disk icon.
2. Double-click on the SIERRA GAMES drawer.
3. Click on the drawer for the desired Sierra game.
4. Click on the game icon.

ALL SYSTEMS
MOVING YOUR CHARACTER
You may move your character on the screen with the [Arrow] keys, the numeric keypad,
the joystick, or the mouse. To halt your character's steps with the keypad, press the
number 5, or press the last used direction key again. Do not attempt to move the
character by holding down the direction key. This will cause the character to start
and stop continuously, resulting in very slow progress.
Using the mouse, position the arrow where you want the character to move, then click
the left mouse button (if your mouse has multiple buttons).

\ t

MENUS
When you press [ESC], a menu bar will appear at the/top of your screen with several
menus that can be opened to show the command choices available to you.

KEYS TO USE IN THE MENUS
Use the left and right [Arrow] keys to open a menu, and the up and down [Arrow] keys
to highlight items within a menu.
Press [ENTER] to select a highlighted command.
Press [ESC] to return to the game without choosing a command.

GAME SPEED CONTROL
At times it may be useful to slow down the speed of the game animation in order to
negotiate a tricky section, or observe something more carefully. At other times, you may
wish to speed up the game actions. To increase or decrease animation speed, choose
FASTER or SLOWER from the Speed Menu, or use the [+] key to increase speed, the
[-] key to decrease speed,-or the [=] key to return to normal animation speed.
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SHORT CUTS FOR COMMON COMMANDS
You can use function and control keys to short cut many common commands.
[Fl]
[F2]
[F3], [Spacebar]
[F5]
[F7]
[F9]
[Tab]
[Ctrl-I]
[Ctrl-P]
[Ctrl-Q]

[=]
[Ctrl-V]

Help
Toggle sound on/off
Repeat previous command
Save Game
Restore (saved) Game
Restart Game (from beginning)
Inventory
Inventory
Pause Game
Quit Game
Increase Animation Speed,
Decrease Animation Speed
Normal Animation Speed
Change Volume

USING YOUR TAB KEY
While playing Sierra games, your [Tab] key will perform two major functions. You will
use it to review the items in your inventory, and also (if you're not using a mouse) to
select options from certain menus. The following menus will require the use of the [Tab]
key for highlighting menu options:

Menu Choose from
Restart Game..... Restart, Continue
Quit Game Quit, Don't Quit
Save Game Save, Cancel, Change Directory, Replace
Restore Game Restore, Cancel, Change Directory
[Death Message Box] Restore, Restart, Quit

USING THE MOUSE (optional)
To move your character using the mouse, position the arrow to where you want the
character to move, then click the left mouse button.

RETYPING COMMANDS
If you wish to repeat a command select RETYPE from the ACTION menu or press the
[SPACEBAR] or [F3].

INVENTORY
If you wish to see the items you are carrying, select INVENTORY from the Action menu,
press [Ctrl-I], or press the [Tab] key. A list of the items you are carrying will be displayed.
To look more closely at an item, use your [Arrow] keys to highlight the item and press
[ENTER]. A picture of the item, along with a brief description, will appear on your
screen. Press [ENTER] or [ESC] to resume play.


